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Getting Started 

About this Manual 
This manual contains information about how to use the Star Custom 
Report Writer (also referred to as the Star Report Writer).  It consists 
of the following sections. 

This section contains a brief overview of the software, the manual, 
and terms used in both the software and the manual. Instructions for 
installing the Star Report Writer are also included in this section. 

Creating Custom Report Templates, page 15—How to create a 
template that can be used to automatically generate custom printed 
reports.  This section also describes the report objects that can be 
included in the template. 

Interactive Viewing and Printing of Reports, page 53—How to 
use Star Report Writer to view and print custom reports. 

Specifying Report Templates in Methods, page 63—How to 
specify in your Method the report template you wish to use to 
generate custom reports during automated injections and 
recalculations. 

Automatically Generating Reports, page 69—How to 
automatically invoke Star Report Writer from System Control to 
generate custom reports after each run. 

Troubleshooting, page 71—Lists error messages and other 
problem symptoms, along with suggested actions for correction. 

Other sources of information are available to help you get the most 
from this product. 
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On-line Help 
Help is available directly from the Star Report Writer application. 

 

Select Help Topics 
from the Help menu. 

The on-line help describes each of the menu items, dialog boxes and 
windows in the Star Report Writer application. 

Topics in the on-line help may be printed, and you may view 
keywords or search for specific text.  This reference information is 
useful as you explore the software. 

Release Notes 
Release notes accompany the software and contain up-to-the-
minute information that may be more recent than information in this 
manual.  Refer to the release notes before installing or using the 
software. 

Demonstration Templates 
Included with the software and referenced from this manual are 
several Star Report Writer templates that demonstrate techniques 
and principles important for most effective use of the software.  
Throughout this manual, you will see references to specific 
templates that contain information demonstrating a particular topic. 

 Try it out! 

This symbol will be used when making references to these 
templates. 

Sample Templates 
Also included with the software are sample templates that you may 
use as-is, or modify to meet your specific needs.  The following 
samples are located in the Examples directory where the Star Report 
Writer software is installed: 

4 03-914740-00:4 



 GETTING STARTED 
 What does the Star Custom Report Writer do?  

ES_ANLYS.WRT, ES_CALIB.WRT and ES_VERIF.WRT—templates for 
analysis, calibration and verification runs that use an external 
standard. 

IS_ANLYS.WRT, IS_CALIB.WRT and IS_VERIF.WRT—templates for 
analysis, calibration and verification runs that use an internal 
standard. 

STANDARD.WRT—a template approximating the report generated by 
the standard Report application in the Star Chromatography 
Workstation. 

VLOGO.WRT—a concise template containing a logo, summary 
information about the run, a chromatogram and results table. 

What does the Star Custom Report Writer do? 
The Star Report Writer allows you to design a template that, when 
applied to your chromatographic Data Files, generates a report. 

Star Report Writer allows you to visualize your report with real data 
as you create the template, eliminating the trial-and-error process 
often found when configuring reports.  Star Report Writer provides 
you with unparalleled flexibility in the format of your report.  You can 
change font type, size, style, color and orientation.  You can add 
boxes, borders, and annotations. You can add graphic images or 
portions of other documents pasted in from the Windows clipboard.  
With Star Report Writer, you have the ability to automatically 
generate publication-quality documents. 

You can create comparative reports where the results, 
chromatogram or other information from a reference Data File is 
presented next to the active Data File.  You can also format your 
report to include data from multiple channels from the same Data 
File. 

Once you have created a template, you select it in the Method that 
will be used to perform your chromatographic runs.  A separate 
template can be used with each channel of data from each detector 
in your system, and you can name templates specific to the type of 
sample (unknown, calibration, or verification). 
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Not only can you use Star Report Writer to automatically generate 
printed reports, but you can also review reports interactively on 
screen.  Multiple reports can be viewed at once, and new templates 
can be linked to chromatographic Data Files for later viewing or 
printing. 

 

Installing Star Custom Report Writer 
 

Note:  If you have not already installed the Star Workstation on your 
computer, do so before proceeding. 

Star Custom Report Writer is installed from the Star Workstation CD. 
Refer to the booklet included with the CD for instructions on installing 
software. When you run the Star Custom Report Writer installation, 
you will be prompted for your Star Custom Report Writer serial 
number, which appears on the software serial number card included 
with the product. 

When Star Report Writer is installed, the Star Workstation will be 
configured to automatically generate custom reports after each 
injection when your Method specifies a custom report template. 

Glossary of Star Report Writer Terms 
The following Star Report Writer terms are used throughout this 
manual.  You will also find information about these terms in the on-
line help. 

Active object—A report object that has been activated for editing by 
double clicking on it.  Click anywhere outside the active object to 
return it to its inactive mode allowing it to be positioned with the 
mouse. 

Auto Scale—A setting in the chromatogram properties used to 
automatically set the scaling to fit the highest and lowest data points 
in the chromatogram. 
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Automation Files—The report object that lists the SampleList and 
Sequence that were used for injection, and the application, version, 
RecalcList and Sequence used for the most recent calculation.  

Border—A report object in the General tab of the Section window 
that allows separator lines to be placed on the template to visually 
break the printed report into sections.  This differs from the Border 
Style in the Palette window. 

Border Style—Found in the Palette window and is used to select 
the border to be applied to an object.  The three types of border 
styles are none, a solid line, and a dashed line. 

Calibration Section—The Section window tab that contains 
calibration objects that can be individually positioned in the template. 

Calibration Data File Log—A report object used to print a table of 
the Data Files used for generating the calibration data. 

Calibration Coefficients—A report object used to print a table of 
the calibration coefficients for all the peaks in the peak table. 

Calibration Replicate Stats—A report object used to print a table of 
the integration results of all peaks in the peak table.  A complete 
table is only available from the last Data File in the calibration set 
(and subsequent Analysis Data Files). 

Calibration Summary—A report object that lists information about 
the calibration curve fit and conditions used to calculate the 
calibration data. 

Chromatogram—A report object used to print the chromatogram, 
peak annotations and associated items. 

Chromatogram Scaling—A setting in the chromatogram properties 
that can be used to either select Auto Scale or Fixed Parameters.  
When Fixed Parameters is selected, the minimum and maximum 
values for the detector response and the start and end time of the 
chromatogram can be entered. 

Clear—Found in the Palette window, this button is used to give an 
object a clear background.  This is especially useful when overlaying 
or superimposing one object on another. 
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Close Report—A File menu selection that closes the currently 
selected report template.  If the template has not been saved, you 
will be prompted to save it before the template is closed. 

Computer Info—A report object that lists the computer hardware 
and operating system information for the computer used during 
injection and any subsequent data calculations. 

Container Object—A type of report object containing fields that can 
be individually moved within the object.  Container objects include 
Run Description, Data Handling Params, Notes, Automation Files, 
Detector Info, Computer Info, and Calibration Summary. 

Data File Section—The Section window tab that contains objects 
specific to the Data File.  These objects can be individually 
positioned in the report template. 

Data File/Channel Name—A report object that lists the Data File 
name and the channel being reported in the active Data File. 

Data Handling Errors—A report object that lists the errors that 
occurred during data handling. 

Data Handling Params—A report object that lists the parameters 
that were set in the data handling section of the Method. 

Data Handling Time Events—A report object that lists each data 
handling time event (such as programmed peak width changes) and 
the time that it occurred. 

Data Source—A File menu selection used to specify the Data File 
and detector channel for a selected object.  You can access this 
dialog box from the context menu with a right mouse click on the 
active object. 

Delete Header Footer—A Page menu selection that deletes all 
entries from the header and footer, and resets the header and footer 
to their default size.  The contents will be deleted even if Show 
Header/ Footer is not checked. 

Detector Info—A report object that lists the data acquisition rate, the 
detector run time, detector type, and other detector parameters.  
This object contains fields that can be individually positioned in the 
report  template. 
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Field—A unit of information contained in an object.  For example, the 
Run Description object contains individual data fields.  Fields within 
an object can be edited individually or as a group. 

Fields Displayed—Refers to the list of fields that are contained in 
an object.  Fields can be displayed or suppressed from the 
Properties dialog box of the object. 

File Marks—A report object used to print a table of the name and 
retention time for any event marks in the data file. When the object is 
active (done by double clicking on it), you can move columns and 
change column widths by clicking and dragging their headers.  

General Section—The Section window tab that contains objects to 
add text, pictures, time & date and page numbers to the report 
template. 

Generated Text—A report object that allows the display and 
formatting of a text file. It can be used to display a text file whose 
name is based on the data file, or any text file you specify. 

Insert New Page—A Page menu selection that adds a new blank 
page to the report template before the current page. You can append 
a new page to the end of the template by using Add Page to End. 

Instrument Section—The Section window tab that contains objects 
specific to the instrument used to generate the Data File.  These 
objects can be individually positioned in the report template. 

Int. Std. Amounts—A report object that lists the internal standards 
used and the amounts of each of them. 

Link Template to Data File—A File menu selection used to make 
the active template the default analysis, calibration or verification 
template for that file.  It is grayed out in the file menu until both a 
template and a Data File have been selected for viewing. 

Lock Channel—A data source selection used to select the data 
handling channel that will always be used for this object.  Select the 
channel from the list box. 
Lock Template—An Edit menu selection used to specify a 
password that will be required to modify the template in the future.  
Once locked, the password must be supplied to unlock and modify 
the template. 
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Module Info Log—A report object that lists the data for each module 
in the instrument.  These data are entered using the Module 
Information Editor in System Control.  Adjust the object size to allow 
for all information to be printed. 

New Template—A File menu selection used to create a new 
Template window which will appear as a blank page.  To add a 
report object to the template, drag the icon for the object from the 
Report Sections window onto the page. 

Notes—A report object that lists the injection notes that were 
entered in the SampleList and any calculation notes that may have 
been entered in the RecalcList during recalculation. 

Open Report—A File menu selection used to select the Data File 
and the template that will be used to generate a report. 

Overflow Printing—A File menu selection used to print overflowing 
objects.  Objects such as the Results Table or Run Log, whose 
length may vary from run to run depending on the number of 
detected peaks or instrument events, may overflow the size of the 
object as set in the template.  When overflow printing is enabled 
(checked), these objects will be continued on subsequent pages, 
repositioning all following report objects on the page down and 
potentially onto another page.  Report objects always maintain their 
order, even when overflow occurs. 

Page Number—A report object used to number the pages on the 
printed report. 

Palette—A Layout menu selection that displays the Palette window.  
It is used to set the text/border and background colors for an object 
(or entire page).  The buttons at the bottom of the window allow the 
selection of a border to be applied to an object. 
Peak Range—A setting in the Results Table, Calibration 
Coefficients, Calibration Replicate Stats, and Calibration Data File 
Log properties, used to choose between the display of all peaks in 
the table or only those peaks in the designated range. 

Picture—A report object that allows you to add a bitmap or Windows 
metafile graphic, such as a company logo, to the template. 

Position—A Layout menu selection used to change the position of a 
selected object relative to other objects in the template.  For 
example, you can place a text object on top of a chromatogram 
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object.  By changing the background color to clear, they can be 
superimposed.  Four options are available to position an object: to 
front, forward one, back one, and to back. 

Print Date/Time—A report object used to show the date and time 
the report was printed.  The format of the date and time is selected 
from the object’s properties dialog box. 

Print Preview—A File menu selection that opens the Print Preview 
window, which displays the report as it will be printed.  Useful when 
designing report templates and reviewing multi-page reports. 

Properties—A Layout menu selection used to adjust the 
appearance of report objects.  Report objects have properties that 
affect the information they contain and how it is formatted in the 
report.  Different types of objects have different properties.  The 
Properties dialog box allows you to change the data that is displayed 
in the object. 

Report Sections—A View menu selection used to display the 
Report Sections window.  Star Report Writer groups information 
about your analysis into four sections: Data File, Instrument, 
Calibration and General. 

Results Table—A report object used to print a table of the numerical 
results of peak integration.  When the object is active (done by 
double clicking on it), you can move columns and change column 
widths by clicking and dragging their headers. 

Revision Log—A report object that lists the time, date and the 
Method used for each recalculation of the Data File.  Data file 
Versions are also listed in this object if the Access Control and Audit 
Trail software is installed on the Workstation. 

Run Description—A report object that contains fields that identify 
the Data File.  Fields can be individually positioned in the template 
and can also be disabled from the Properties dialog box. 

Run Log—A report object that lists the instrument (hardware) 
parameters as specified in the Method. 

Sample Prep Info—A report object that lists the rack and vial 
number, number of injections, and injection volume for the sample. 
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Save Template—A File menu selection that saves the currently 
selected template with its existing name.  If the template has not 
been named, the Save Template As... dialog box will be displayed, 
allowing you to specify a name. 

Save Template As...—A File menu selection that allows you to 
specify a name and location for the currently selected template. 

Sections—Same as Report Sections. 

Select All—An Edit menu selection that selects all the objects in the 
template, or all the fields in an object if the object is active. 

Select Data File...—A File menu selection that opens the Select 
Data File dialog box, which you can use to select a Data File for 
viewing with the currently open template. 

Select Permanent Data File—A data source selection used to 
select a Data File to always be used for this object.  Use this function 
to insert the results or chromatogram of a reference Data File next to 
the active Data File. 

Selected Object—A selected object is outlined with a dotted border.  
To select an object, click on it.  When an object is selected, it can be 
moved with the mouse, and its menu can be displayed by right-
clicking.  To cancel a selection, click anywhere outside the selection 
in the template window. 

Show Header / Footer—A Page menu selection that, when enabled 
(checked), the header and footer portion of the template are 
displayed for editing.  Click and drag the separator bar to adjust the 
size of the header and footer.  When displayed, the main portion of 
the template is not accessible for editing.  Objects placed in the 
header/footer portion of the template will be printed on every page. 

Status Bar—A View menu selection that turns on/off the display of 
the Status Bar.  The Status Bar is located at the bottom of the Star 
Report Writer window.  Moving the mouse cursor over an object on a 
template displays the object’s name in the Status Bar.  Moving the 
mouse over a toolbar item displays that tool’s function in the Status 
Bar. 

Template—A file created in Star Report Writer that defines the 
layout of a custom report.  When a Data File is linked to a template, 
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a report is generated (either on the screen, or in print).  Template 
files end in the extension “.WRT”. 

Text—A report object that allows the entering and formatting of free-
form text.  For example, this object can be used to provide additional 
labels on the chromatogram, to write a summary report, to enter 
headings, or to enter the company name, address and phone 
number. 

Toolbar—A View menu selection that toggles the display of the 
Toolbar.  The Toolbar items are shortcuts for several menu 
selections.  Clicking and holding a toolbar item displays that tool’s 
function in the Status Bar. 

Use Active Data File—An object’s data source selection that uses 
the Data File that was just collected or recalculated (in System 
Control) or selected from the Open Report or Select Data File dialog 
box (from Star Report Writer).  You can alternatively specify a 
permanent Data File as an object’s data source. 

Use Active Channel—An object’s data source selection that uses 
the active detector channel specified in the Method (during 
automation) or specified when the Data File is selected (in Star 
Report Writer). To create a two channel report, one object can use 
the active channel and the second can be a locked channel or a 
Data File that is selected permanently. 
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Creating Custom Report 
Templates 

Creating a New Report Template 
The Star Report Writer application allows you to create new report 
templates, view the templates with real Data Files, and print the 
reports. Star Report Writer may be launched from the Star Toolbar. 

 

 
Click on the Star Custom 
Report Writer button. 

 

 

 

If the Data File you wish to view 
appears in a QuickLink button, select 
View Custom Report from the menu. 

If you did not select View Custom Report from a QuickLink menu, an 
empty template is automatically opened in the Report Writer window, 
otherwise, the custom report associated with the Data File in the 
Quick Link button is opened.  If you wish to create another new 
template, pull down the File menu. 

Star Custom Report Writer 15 



 

The template is displayed as an empty page in the main portion of 
the Star Report Writer window. 

 

To change the 
amount of the 
template page 
visible, adjust 
the zoom factor. 

Click on the New Template item. 

The page is resized with the selected zoom factor. 
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 Selecting a Data File to View While Building a Template  

 

Scroll to see the 
entire page. 

The white area 
represents the 
printed page. 

 

Selecting a Data File to View While Building a Template 
You may wish to view data from a Star Workstation Data File while 
you are creating or editing your report template.  To select a Data 
File for viewing, pull down the File menu. 

 

Click on Open Data 
File. 
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The Open Data File dialog box is displayed. 

 
 

Select the channel in the Data 
File whose report you wish to 
view. 

Select the Data 
File.  

 
Now, when you place report information into your template, data 
from the selected Data File will be shown. 

Placing Report Information in the Template 
Star Report Writer groups information about your analysis into four 
sections: Data File, Instrument, Calibration and General.  Each 
section contains several report objects.  A single report object 
contains a collection of data items that go together.  Since the 
information is already organized in the report objects, designing a 
report template is easy—you simply place report objects on the 
page, arrange them to your liking, and alter the format and contents 
of each object if necessary. 
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 Placing Report Information in the Template  

When you started Star Report Writer, the Sections window was 
displayed.  If it is not currently open, select it from the View menu. 

 

Click on Report 
Sections. 

The Sections window is displayed. This window can be sized and 
moved to a convenient location on the screen. 

 

Click on the tabs to 
view sections 
containing report 
objects. 

Click and drag report 
object icons onto the 
template. 

Report objects contain 
groups of related 
information, tables, or 
graphics. 

Right-click in the sections 
window to select how the icons 
are displayed (large, small or 
list). 
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When you drop a report icon onto the template, the report object 
represented by the icon is displayed. 

 

The object can now 
be positioned on the 
template page by 
dragging it with the 
mouse. 

 Try it out! 

Open the report template named BEGIN.WRT, located in the directory 
where you installed Star Report Writer. To do so, select Open Report 
from the File menu, then choose BEGIN.WRT from the Template tab. 
This template illustrates some of the techniques described in this 
section. 

Report Object Contents 
The following pages show a report with the default contents of each 
report object.  The objects are called out with the tab name (in the 
Report Sections window) followed by the object name.  For a 
complete description of each object, refer to the on-line help. 
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 Report Object Contents  

 

Data File: Data 
File/Channel Name 

General: 
Border 

Data File: Run Description 
General: 
Print 
Date/Time 

Data File: 
Chromatogram 

Data File: Results 
Table 

Data File: Int. Std. 
Amounts 

Data File: Data 
Handling Params 

General: Page Number 

Objects placed in the page header and footer areas are printed on 
every page of the report.  The header and footer are only shown for 
editing when Show Header/Footer is selected from the Page menu. 
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Data File: Data 
Handling Time 
Events 

Data File: Data 
Handling Errors 

Data File: Notes 

Data File: Revision 
Log 

Instrument: 
Detector Info 

Data File: 
Automation 
Files 

Instrument: Sample 
Prep Info 

Instrument: 
Computer Info 
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Instrument: 
Module Info Log Instrument: Run Log 

Note that the Run Log object on this page has overflowed the page 
boundary and would be continued on the subsequent page.  Refer to 
page 35 for details on how objects overflow their boundaries. 
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Calibration: 
Calibration 
Summary 

Calibration: 
Calibration 
Coefficients 

Calibration: 
Calibration 
Replicate Stats 

Calibration: 
Calibration Data 
File Log 
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Solvent Gradient Display 
If you are using the ProStar/Dynamax HPLC system and you are 
running a solvent gradient, then plots of the gradient profiles will be 
superimposed over the Chromatogram. When viewed on the screen 
or printed on a color printer, each of the solvent profiles will be 
plotted in a different color. A Solvent % scale will also be displayed 
at the right-hand side of the chromatogram. The figure below shows 
an example Chromatogram object that includes solvent gradient 
profiles. 

 

 
You can turn off the solvent gradient display if you wish. Do this by 
modifying the Star32.Ini file as follows: 

1. Click on the Windows ‘Start’ button and then select ‘Run’. In the 
‘Open’ field, type the following: 

 Star32.Ini 
The Star32.Ini file will be loaded into the Window Notepad editor. 
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2. Add a new section to the end of the Star32.ini file by typing the 
following: 

[StarWriter] 
ShowGradient=0 

The end of the Star32.ini file should appear similar to the following 
figure. 

 

3.  Save the modified Star32.ini file. 
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Changing Report Object Properties 
Report objects have properties that affect the information they 
display and how it is formatted in the report.  Different types of 
objects have different properties.  To change the properties of an 
object, first select the object by clicking on it with the mouse in the 
report template.  When the object is selected, a dotted border 
appears around it. 

 

Right click the 
mouse to display 
the object's 
context menu. 

Select Properties. 
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The object’s Properties dialog box is displayed.  Depending on the 
type of object, the contents of the Properties dialog box will vary.  
This is an example of a container object, an object that contains 
individual data fields. 

 

Click OK for the 
changes to take 
effect. 

Highlighted fields 
will be displayed 
in the object. 

Objects containing tables, such as the Results Table or Calibration 
Coefficients, have properties related to table formatting. 

 

These attributes 
affect the entire 
table. 

Select which peaks 
to display. 

Change the 
position and 
size of the 
column 
header. 

Click on fields to 
toggle their display 
status. 

Adjust column 
width, data 
alignment, and 
number of digits 
after the decimal 
point. 

Change the text appearing in the 
column heading by selecting the 
field and typing the new name. 

Select columns to 
display in the table. 
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 Moving Items Within a Report Object  

The chromatogram properties allow you to select the display range 
and choose plot annotations. 

 

Select how the trace 
is drawn. 

Select plot annotations. 

Select items to 
include in the 
chromatogram. 

Autoscale, or specify the 
exact amplitude scaling. 

The chromatogram display 
reflects the current 
options. You can zoom
this chromatogram to 
specify plot ra

 on 

nges. 

The time axis can be 
Autoscaled, or specified 
as a time range. 

For a complete description of each object’s properties, refer to the 
on-line help. 

 Try it out! 

Open the report template named C_GRAM.WRT, RESULTS.WRT or 
RUN_DESC.WRT. These templates illustrate some of the properties of 
the Chromatogram object, Results Table object, and the Run 
Description object. 

Moving Items Within a Report Object 
Items within certain report objects (such as the Run Description 
object) can be moved on the page after the object has been placed 
in the template.  Report objects that contain moveable fields are 
called container objects.  When editing of an object is allowed, a 
wide border appears around the active object.  Clicking outside the 
object returns it to its inactive state, but it is still selected. 
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Activate the object for 
editing by double-clicking 
on it. 

Select multiple fields by dragging a 
rectangle around them, or by pressing the 
Shift key while clicking on them. 

Fields in a 
container object 
can be moved by 
dragging them 
with the mouse. 

 

 

 

Fields within a container object can be aligned using the alignment 
options in the Layout menu. 

 

Select the fields to 
align and choose the 
desired alignment 
option. 
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 Interacting with the Chromatogram Object  

Interacting with the Chromatogram Object 
The chromatogram object’s properties can also be changed when it 
is in the active state. When you zoom in on an area in the 
chromatogram, the time and amplitude ranges are set to correspond 
to the visible portion of the plot.  

 
When active, the chromatogram object behaves the same as the 
chromatogram display in Interactive Graphics, the real-time 
chromatogram display in System Control, and the chromatogram 
display in other Star Workstation applications. 
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Rearranging and Sizing Columns in Table Objects 
Objects containing tables such as the Run Description, Calibration 
Coefficients, Calibration Replicate Stats and Calibration Data File 
Log can have their table columns rearranged and resized by using 
the mouse. 

 

 

 

Click and drag between columns 
to change their width. Click and drag the 

column to change its 
position. 

Activate the table for 
editing by double-clicking 
on it. 

When you click outside the object (returning it to its inactive state), 
you will see that the column position and width changes you made 
are displayed in the report. 
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Adding Pages to a Report Template 
You may create report templates that contain multiple pages.  To 
add a page to a template, use the Page menu. 

 

Add a new page 
after the last page 
in the template… 

…or insert a page 
before the current 
page. 

Add report objects to the new page as you did with the previous 
page.  To change which page is currently displayed, use the toolbar 
navigation buttons. 

 

 

Go to first page. 

 Go to last page. 

Go to the next page. Go to the previous page.
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Adding a Header and Footer 
You may wish to have information printed at the top and bottom of 
each page.  To do so, add a header and footer to your template. 

 

Add and display the 
header/footer in the 
template. 

The current page is shown, but only the top and bottom of the page 
is accessible.  You may now place report objects in these portions of 
the page. 

 

Drag and drop 
objects into the 
header or footer. 

Change the size 
of the header and 
footer by dragging 
the separator bar. 
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 Objects that Overflow their Boundaries  

Once you are satisfied with the header and footer, turn off their 
display to return access to the main portion of the template. 

 

Toggles display 
of header/footer. 

The header and footer are not shown when editing the main part of 
the report template page.  To view the header and footer, select Print 
Preview from the File menu. 

 Try it out! 

Open the report template named H_FOOTER.WRT. This template 
illustrates how to place information such as print date and page 
number in a header and footer. 

Objects that Overflow their Boundaries 
Certain objects’ contents may vary in length depending upon the 
Data File that is applied to the report template.  For example, you 
may add a Results Table to your report template that is sized to fit 
only 10 peaks, but you may later apply the template to a Data File 
containing 20 peaks.  When an object contains more data than can 
be displayed within its specified boundaries, it overflows and pushes 
other report objects on the page down and potentially onto another 
page. 
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With 10 peaks, the 
results table fits on 
the first page. 
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When the same template is used with a different Data File, the 
results table may overflow. 

 

 

The Results Table 
object overflows to 
a second page to 
accommodate 
additional peaks. 

 

Note that report objects only overflow when they are printed, or when 
you preview the printed report using Print Preview (from the File 
menu).  The template that you edit will not show the overflow 
behavior (other than the fact that only a portion of the data is visible 
within the boundary of the object). 
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You can disable overflow printing by selecting the File menu. 

 

The checkmark 
indicates that 
overflow printing 
is enabled. 

Toggle overflow 
printing by selecting 
this menu item.  

 Try it out! 

Open the report template named OVERFLOW.WRT. This template 
illustrates how objects overflow onto subsequent pages.  

Changing an Object’s Text Properties 
You can change a report object’s text style, color, justification, and in 
some cases, the orientation of the text. 

Star Report Writer provides a full range of fonts from which to select.  
It is easy to format different report objects or fields within a report 
object to be printed in different fonts.  To change the font or color for 
all text items in a report object, select the object by clicking on it, 
then right click to get the object’s menu. 
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 Changing an Object’s Text Properties  

 

Select font… 

…or Palette. 

 

If you selected Font, the Font dialog box is displayed. 

 

Select the desired 
font and click OK. 
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If you selected Palette, the Palette window is displayed. 

 

Change the text and border color. 
This also affects a chromatogram 
object's trace color. Change the object’s 

background color. 

Choose a border 
style for the object. 

A clear background allows you to 
place text or chromatogram objects 
over other objects without obscuring 
them. 

 

 

 Try it out! 

Open the report template named RUN_DESC.WRT. This template uses 
a container object to illustrate font selection and palette features. 

You can change the text properties of individual fields within a 
container object (one that contains separate text fields).  Activate the 
object by double-clicking on it. 

 

Select one or 
more fields. 
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Right click to get the field’s menu. 

 

Change the font. 

Change the text or 
background color. 

Change the text 
justification (left, center 
or right). 

Rotate the field. 
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Adding Borders, Background Color, and Graphics 
Report objects can be displayed with a border surrounding them, 
and their background color can be specified. 

To change the border or background color for a report object, select 
the object by clicking on it, then right click to get the object’s menu. 

 

Select Palette. 

The Palette window is displayed.  Refer to Changing an Object’s 
Text Properties on page 38 for a description of the Palette window. 

You can similarly add borders and background color to individual 
fields within a container object by activating the object, selecting the 
fields, right-clicking on them, and selecting the Palette menu item. 
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The Border object, found in the General tab in the Report Sections 
window, allows you to place a border around groups of report objects 
or add separator lines between other report objects in your template. 

 

Drag the border icon 
onto the template. 

The border object can be resized by clicking and dragging any of the 
corners.  Change the line style by selecting the object’s properties 
menu by right-clicking on the object. 

 

Select the desired 
style from the list. 

Borders can be rotated and have their color changed as with text 
objects. 
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You may wish to add graphics images to your report.  For example, 
you may wish to insert your company logo in the page header or a 
scanned photograph of the operator into the report.  Graphic images 
can be added by placing the Picture object in the template. 

 

Drag the Picture 
icon onto the 
template. 

When you drop the object onto the template, you are prompted for 
the name of the graphics file you wish to place. 

 

Select the graphics 
file to open. 
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You may paste a graphic image into your template from the 
Windows clipboard.  This can also be used to paste a chart created 
in a spreadsheet program, a chemical structure created in a drawing 
program, or other images created in Windows applications that 
support use of the clipboard. 

 

The contents of the 
clipboard will be 
inserted into the 
template. 

Inserting OLE Objects into your Template 
Star Report Writer supports the insertion of OLE (Object Linking and 
Embedding) objects into report templates.  

  

Drag the OLE Object 
icon onto the template. 
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When you drop the object onto the template, you are prompted for 
the name of the OLE object you wish to place. 

 

Select an object 
type from the list… 

…or create an 
object from an 
existing document. 

Once inserted, an OLE object allows you to edit its contents as if you 
were running the application that created the document. This “in-
place editing” allows you, for example, to modify a drawing object 
after it has been added to your report template. 

Note:  Not all OLE objects conform strictly to Microsoft’s specifications for 
the OLE software interface.  When using a report template with an 
embedded OLE object, it is recommended that you view and print the 
report prior to automated report generation.   

Overlapping Report Objects 
You may wish to overlay two report objects without having one 
object cover up information on the other.  This is useful, for example, 
if you wish to overlay two chromatograms, or if you wish to add text 
annotation to a chromatogram. 
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To do so, change the background color of the object that will appear 
“on top” by selecting the Palette window by right clicking on the 
object. 

 

This text 
object has 
been selected. 

Select Palette. 

The Palette window will be displayed. 

 

Select clear to make the 
object’s background 
transparent. 
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Now when you place this object on top of the other object, the other 
object will still be visible. 

 

The text object 
appears on top of 
the chromatogram. 

To change which object is on top, right click on the topmost object. 

 
Change the position of 
the overlapped objects. 
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Specifying the Report Object’s Data Source 
Normally, when you print reports during automated injections or 
recalculations, a report object’s data is obtained from the Data File 
currently being processed by System Control.  You may, however, 
specify a fixed file as the data source for a report object.  This is 
useful, for example, if you wish to show the chromatogram plot from 
a standard run in addition to the chromatogram plot from the current 
run. 

Report templates are specified for each detector channel in the 
Method Builder, therefore each channel may have its own report.  
The default detector channel for a report object is the same as the 
channel specified in the Method.  You may also lock a report object’s 
detector channel to something other than the default.  This is useful, 
for example, if you wish to show chromatograms for both channel A 
and channel B of an ADC board on the same report. 

To change an object’s data source, select the object by clicking on it.  
Then right click to display the object’s menu. 

 Select Data Source. 
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The Data Source dialog box is displayed. 

 

Use the Data File 
generated from System 
Control. 

Use the Data File 
generated from 
System Control, but 
specify a fixed 
channel. 

Use a specific Data 
File and channel. 

 Try it out! 

Open the report template named MULTI_CH.WRT. This template 
illustrates how to create a multi-channel report by fixing the channel 
number for a chromatogram object and results table. The template 
REFCGRAM.WRT demonstrates how to create a report that shows a 
reference chromatogram in addition to the chromatogram for the 
current run by specifying the reference chromatogram’s Data File in 
the chromatogram object’s data source. 
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Specifying a Password for a Report Template 
Template files can be locked with a password for editing and saving.  
To lock a template, pull down the Edit menu. 

 

Select Lock 
Template. 

 

The Lock Template dialog box is displayed. 

 

Check this box to 
enable locking. 

Enter a password 
for this template. 

If you have not saved the template, you will be prompted to do so. 

Once the template is locked, fields cannot be moved, added or 
changed, and the template file cannot be saved without changing the 
name.  If you save a locked template under a different name, the 
new template will not be locked. 
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To unlock a template, pull down the Edit menu. 

 

Select this item to 
unlock the  template. The checkmark 

indicates the template 
is currently locked. 

 

The Unlock Template dialog box is displayed. 

 

Enter the password 
used when locking 
the template. 
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Interactive Viewing and Printing of 
Reports 

Opening an Existing Report Template and Data File 

The Star Report Writer application allows you to view and print 
reports made by associating a report template with a Data File. 
Star Report Writer may be launched from the Star Toolbar. 

 

 

 

 

 

 

If you clicked on View Custom Report from a QuickLink menu, 
the custom report associated with the Data File in the Quick Link 
button is opened. If you clicked on the Star Custom Report 
Writer button in the Star Toolbar, an empty template is 
automatically opened in the Report Writer window.  

Click on the Star Custom 
Report Writer button. 

If the Data File you wish to view 
appears in a QuickLink button, select 
View Custom Report from the menu. 



To open an existing report template and Data File, pull down the File 
menu. 

 

Click on the Open 
Report item. 
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 INTERACTIVE VIEWING AND PRINTING OF REPORTS 
 Opening an Existing Report Template and Data File  

The Open Report dialog box is displayed. 

 

Click on the Template 
tab to choose an 
existing template file. 

Select the Data 
File you wish to 
view.

Select this to load the 
template used with this 
Data File when run from 
System Control. 

The report will be displayed in the Star Report Writer window. 
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Viewing the Report 
After you have opened the Data File and template, you may view the 
report on the screen. 

Use the scrollbars to view the entire page, or change the zoom 
amount using the Zoom item in the View menu.   

 

To change the 
amount of the 
template page 
visible, adjust 
the zoom factor. 

 

If the template contains multiple pages, use the navigation buttons 
on the toolbar or the corresponding items in the Page menu. 

 
Go to last page. 

Go back one page. Go to first page.  
Go forward one page.  

 

Note that this view of the report does not show objects that have 
overflowed their boundaries.  Refer to page 60 for details on how to 
view the report exactly as it will be printed. 
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Performing Operations on the Data File 
The Quick Link button, available in the Data File Options toolbar, 
provides access to various operations on the Data File currently 
being displayed in Star Report Writer. 

 

The Quick Link menu 
shows options available 
on the Data File. 

You may use the View/Edit Chromatogram option, for example, to 
modify data handling parameters that affect results.  After you 
perform a recalculation on the detector channel being displayed in 
the report, the report is automatically updated to reflect the changes. 

Star Custom Report Writer 57  



Applying a Report Template to a New Data File 
If you wish to view a different Data File using the current template, 
pull down the File menu. 

 
 

Click on Open 
Data File. 

The Open Data File dialog box is displayed. 

 

Select the 
Data File. 

Select the channel in 
the Data File whose 
report you wish to view. 
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 Applying a Report Template to a New Data File  

Now the current template contains data from the selected Data File. 

You may link the current template to the current Data File so that you 
can more easily load them together from the Open Report dialog box 
(see page 53).  To do so, pull down the File menu. 

 

Select Link Template to 
Data File. 

 

The Link Template to Data File dialog box will be opened. 

 

Choose the run 
type that you want 
associated with this 
template. 
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Previewing the Printed Report 
The view of the report in the Star Report Writer main window shows 
all of the report objects and their contents, but it does not show 
objects that may have overflowed their boundaries (see page 35).   

 

To see the report exactly as it 
will be printed, select Print 
Preview from the File menu. 

The Print Preview window is shown. 

 

Print the report. 

View the next 
page of the report. 

Show two adjacent 
pages. 

Zoom in to see 
more detail. 

Return to the 
main window. 
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Printing the Report 
To print the report from the main Star Report Writer window, pull 
down the File menu. 

 

Select Print. 

 

The Print dialog box is displayed. 

 

Click on OK to 
print the report. 

Choose the page 
range.  This range 
refers to pages in 
the template, not 
necessarily pages 
in the printout. 

Change the 
printer settings. 

The report is printed with the information from the selected Data File 
shown in the template.  If any of the report objects are smaller than 
the data that fills them, and if the Overflow Printing option is checked 
in the File menu, then Star Report Writer may print extra pages. 
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Specifying Report Templates in 
Methods 

Creating a Star Report Writer Method Section 
Once you have created report templates in Star Report Writer, you 
can use them to automatically generate reports after each run 
performed in System Control.  To do so, add a Star Report Writer 
section to the Method that you will use in System Control.  

Method Builder may be launched from the Star Toolbar. 

 

 

 

Click on the Method 
Builder  button. 

If the Method you wish to edit appears 
in a QuickLink button, select View/Edit 
Method from the menu. 

 

 

The Method Builder is opened.  Open the Method file that you will 
use from System Control to perform automated injections, 
recalculations, or print jobs.   
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Create a new Post-Run Method section by clicking on the Add Post-
Run Processing button on the Method Builder toolbar, or by pulling 
down the File menu. 

 

Click on Add Post-Run 
Processing to create a 
new section. 

The Star Assistant Wizard is displayed. 

 

Select the detectors 
whose data you wish 
to report. 
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 SPECIFYING REPORT TEMPLATES IN METHODS 
 Creating a Star Report Writer Method Section  

After selecting the detector(s) whose data you wish to report, you will 
be prompted for the detector channel(s) and post-run actions. 

 

Each channel can be 
reported separately. 

All post-run actions 
are listed. Make sure 
Star Custom Report 
Writer is selected. 

A Star Report Writer section is created corresponding to the selected 
detector(s) and channel(s).   
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The Star Report Writer Method section window is displayed on the 
right panel of the Method Builder window when you click on the 
corresponding entry in the left panel. 

 

 

 

 

Templates associated with 
each run type are listed here. 

 You can print 
multiple copies of 
the report.  

Check here if you only want reports 
generated after recalc and print actions 
(not injections) in System Control. 
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 Specifying Report Templates for Analysis, Calibration and Verification Runs  

Specifying Report Templates for Analysis, Calibration and 
Verification Runs 

You are able to specify different templates for each type of run: 
Analysis, Calibration or Verification.  This allows you to have custom 
reports specific to the sample type.  For example, you may wish to 
include different information in your report for a calibration sample 
versus an unknown. 

 

 

Select the run type. 

Select the 
corresponding template 
by browsing. 

 

Make sure that the templates that you specify in the Method are 
accessible from the computer running System Control.  If you are 
referring to report templates located on a network server, make sure 
the computer running System Control has access to the network 
directory and that the drive mappings are the same. 
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Editing the Report Template from the Method Builder 
You may wish to review or edit the templates that you specify in the 
Method Builder.  To do so, select the template you wish to edit. 

 

Click on Edit 
Template to invoke 
Star Report Writer 
with the specified 
template. 

Star Report Writer will be opened showing the template you 
specified.  You may change the template, select a Data File to view, 
and save the template if you wish.  The Method only refers to the 
template by name (it does not include the contents of the template in 
the Method file), so changes made to the template in Star Report 
Writer will be used during automated report printing. 
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Automatically Generating Reports 

Printing Reports from System Control 
When Star Report Writer is installed, report generation occurs 
automatically after each injection, recalculation or print action in 
System Control.  Make sure that the Method you are using contains 
Star Report Writer sections corresponding to the detectors in your 
instrument (see page 63). 

Disabling Printing During Automation 
If you wish to stop report printing during automation, disable 
automated printing from System Control. 

 

A checkmark here 
indicates that automated 
report printing is enabled. 
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Suppressing Printouts on Injections 
If you wish to only print reports during recalculations and print 
actions (and not injections), edit the Star Report Writer Method 
section. This feature is useful if you wish to run a few replicates of 
your sample, select the most suitable run, and then modify the 
template to create a custom report. 

 

 
A checkmark here 
indicates reports are only 
to be printed for recalc and 
print actions. 
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Troubleshooting 

Error Messages 
When encountering error messages in the Star Custom Report 
Writer or in the Sequence Log in System Control/Automation, refer to 
the following tables.  The messages are listed in alphabetical order. 

 

Error Message A template must be selected to open a report. 

Location Message Box displayed in Star Report Writer. 

Description You have used the Open Report dialog box to 
select a Data File, but you have not selected a 
report template. 

Corrective 
Action 

Select both a template file and a Data File in the 
Open Report dialog box, or, if you just want to 
apply a Data File to the template on the screen, 
use the File:Select Data File menu item. 

 

Error Message Attempted to open corrupt or missing Data File. 

Location Message Box displayed in Star Report Writer. 

Description The Data File that was opened cannot be read by 
Star Report Writer. 

Corrective 
Action 

Verify that the Data File exists and can be read by 
other Star Workstation applications. 
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Error Message Error updating runfile. 

Location Message Box displayed in Star Report Writer. 

Description You attempted to link a template to a Data File and 
Star Report Writer failed to copy the necessary 
information. 

Corrective 
Action 

Check that both the template file and the Data File 
exist and you have write access to them. 

 

Error Message Failed establishing DDE link! 

Location System Control Sequence Log during automation. 

Description System Control and Star Report Writer could not 
communicate via AutoLink. 

Corrective 
Action 

Close any additional applications that are running.  
If the problem persists, restart Windows and try 
again. 

 

Error Message Failed opening Data File. 

Location System Control Sequence Log during automation. 

Description While attempting to automatically print the report 
for the current Data File, the Data File specified in 
the RecalcList could not be read by Star Report 
Writer. 

Corrective 
Action 

Verify that the Data File being processed exists and 
can be read by other Star Workstation applications. 

 

Error Message Failed opening runfile or template. 

Location System Control Sequence Log during automation. 

Description While attempting to automatically print the report 
for the current Data File, either the template 
specified in the active Method or the Data File 
specified in the RecalcList could not be read by 
Star Report Writer. 

Corrective 
Action 

Verify that the template specified in the active 
Method exists in the directory shown in the Star 
Report Writer Method Section.  Verify that the Data 
File being processed exists and can be read by 
other Star Workstation applications. 
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 Error Messages  

Error Message Incorrect template file or pathname. 

Location Message Box displayed in Method Builder. 

Description Attempted to edit a missing or corrupt template 
from the Method Builder. 

Corrective 
Action 

Verify that the template specified in the Method 
exists in the directory shown.  Use Browse to locate 
the template file. 

 

Error Message Insufficient memory to complete copy to clipboard. 

Location Message Box displayed in Star Report Writer. 

Description Attempted to copy an object into the clipboard and 
failed due to lack of memory. 

Corrective 
Action 

Close any other applications that are running.  If 
message persists, restart Windows and try again. 

 

Error Message StarWriter method section not found in Data File. 

Location Message Box displayed in Star Report Writer. 

Description Star Report Writer failed to link a template to a 
Data File. 

Corrective 
Action 

Check that both the template file and the Data File 
exist and you have write access to them. 

 

Error Message You must save a locked file to another name. 

Location Message Box displayed in Star Report Writer. 

Description You attempted to save a template that has been 
locked with a password using the same file name. 

Corrective 
Action 

Once you have locked a template using a 
password, either save it with a new name (which 
removes the lock on the newly saved file), or 
unlock the file before saving it. 
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Other Problem Symptoms 
Some problems do not result in an error message.  Refer to the 
following table for symptoms and recommendations for recovery. 

 

Symptom When rotating multi-line text, the text is collapsed 
into a single line. 

Corrective 
Action 

Multi-line text cannot be rotated without being 
turned into a single line.  If you wish to rotate multi-
line text, create multiple single-line text objects and 
rotate them individually. 

 

Symptom Changing the decimal point separator in the 
Windows Control Panel affects all numbers except 
for the Chromatogram retention times and time 
axes. 

Corrective 
Action 

The Chromatogram display cannot change the 
decimal point separator. 

 

Symptom Copying items to the clipboard results in an 
insufficient memory error. 

Corrective 
Action 

This error occurs primarily with bitmaps.  Try 
reducing the size of your bitmap before copying it 
to the clipboard. 

 

Symptom When multiple objects are rotated, they change 
position. 

Corrective 
Action 

When you rotate multiple objects at once, each 
object is rotated independently.  This may result in 
the unexpected placement of the objects and some 
objects may appear on top of each other.  Either 
rotate each object separately, or rearrange the 
objects after rotating them. 
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 Other Problem Symptoms  

Symptom A “#” sign is shown in the Standard Deviation 
column of the Calibration Replicate Statistics 
object. 

Corrective 
Action 

The “#” sign indicates that there are too few points 
to calculate the standard deviation. 

 

Symptom Information in an object appears blank even though 
a Data File has been selected. 

Corrective 
Action 

Check the data source for the object that contains 
blank fields.  If the data source has been fixed to a 
Data File that cannot be found, or if the channel 
has been fixed to one that does not exist in the 
selected Data File, the object will contain blank 
fields. 

 

Symptom Templates developed on one computer do not look 
the same when printed on another computer. 

Corrective 
Action 

The page size displayed in Star Report Writer is 
based on the currently selected printer (see the 
Printer Setup dialog box).  If you place objects near 
the edge of the page and print them on a printer 
with a smaller printable page size, these objects 
may be omitted from the printout. 

 

Symptom Printing takes a long time on dot matrix printers. 

Corrective 
Action 

All Star Report Writer objects, including text 
objects, are sent to the printer driver as graphics.  
Try decreasing the graphics resolution setting of 
the printer. 

 

Symptom Fonts in templates developed on one computer do 
not look the same when printed on another 
computer. 

Corrective 
Action 

The font selected for the template is not available 
on the computer and Windows has substituted 
another font.  Verify that all computers that will print 
the report have the proper fonts available. 
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